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 ET-EASY168 STAMP เปนบอรดไมโครคอนโทรเลอรในตระกูล AVR8 ขนาดเล็กจ๋ิว โดยมีขนาด

ของบอรดเพียง 2cm x 5cm เทานั้น ซึ่งขนาดบอรด ประมาณเทากับตัวถังของไอซี 28 DIP 300 โดยเลือกใช

ไมโครคอนโทรเลอรตระกูล AVR8 เบอร ATmega168 ของ ATMEL เปน MCU ประจําบอรด โดยเลือกใช 

MCU ที่มีรูปรางตัวถังแบบ 32 TQFP พรอมวงจรรอบนอกที่จําเปนอยาง Oscillator และ Reset รวมไวดวย

ภายในบอรด นอกจากนี้แลวภายในตัวบอรดยังไดรวมเอาไอซี USB Bridge ของ FTDI เบอร FT232R เพื่อ

ใชติดตอส่ือสารแบบอนุกรมดวย RS232 กับคอมพิวเตอร PC ผานทางพอรต USB ไดโดยตรง 

 ทําใหบอรด ET-EASY168 STAMP เปนบอรดทดลองขนาดเล็กที่เพียบพรอมไปดวยวงจรพื้นฐานที่

จําเปนตอการใชงานไมโครคอนโทรลเลอรตระกูล AVR8 อยางแทจริง เพียงแตเสียบสาย USB จากพอรต 

USB ของเคร่ืองคอมพิวเตอร PC เขากับข้ัว USB ของบอรด ET-EASY168 STAMP ก็สามารถทําการเขียน

โปรแกรม และ Download Code ใหกับ MCU เพื่อทําการทดลองไดทันที  

 

คุณสมบัติของบอรด 
 เลือกใช MCU ตระกูล AVR8 เบอร ATmega168 ของ ATMEL Run ความถี่ 16.00 MHz  

o มีหนวยความจํา Flash สําหรับเขียนโปรแกรม 16KByte ถาใชการพัฒนาโปรแกรมผาน

ระบบ AVRISP หรือ 14Kbyte เมื่อใชการพัฒนาโปรแกรมผานระบบ Boot Loader RS232 

o มี SRAM ใชงานขนาด 1KByte และ EEPROM ใชงานขนาด 512 Byte 

o มี GPIO ใชงานจํานวน 22 บิต  

 Digital GPIO จํานวน 14 บิต 

 Analog Input (ADC) ขนาดความละเอียด 10บิต จํานวน 8 ชอง 

 ใชงานกับแรงดันไฟตรงขนาด +5VDC โดยใชไดทั้งกับแหลงจาย +5VDC/500mA จากพอรต USB 

และจากแหลงจาย +5VDC จากภายนอกไดดวย พรอม LED Power แสดงสถานะของแหลงจาย 

 มีวงจร External Reset แบบ RC Reset และ Switch Reset พรอมภายในบอรด 

 ข้ัวตอใชงานวางตัวบน Pin Header ระยะหาง 2.54mm(100mil) ขนาด 28 Pin (ดานละ14Pin) 

ระยะหาง 600mil(1.5cm) งายตอการนําไปตอประยุกตใชงาน และ ขยายวงจร I/O สามารถใชกับ 

Project Board และ PCB เอนกประสงคไดโดยงาย 

 มีข้ัวตอ USB สําหรับเช่ือมตอส่ือสารกับคอมพิวเตอร PC ผาน USB Bridge ของ FTDI ในรูปแบบ

ของการส่ือสารอนุกรม RS232 สําหรับใชงานส่ือสารและ Download  Code ใหกับ MCU ในบอรด 

 มีข้ัว AVRISP แบบ IDE 10PIN สําหรับใช Download โปรแกรมใหกับ MCU ภายในบอรดในกรณี

ไมตองการใชการพัฒนาโปรแกรมผานทาง Boot Loader 

 มี LED แสดงสถานะ โดยตอกับ PB5 ของ AVR (Digital-13 ของ Arduino Project) สําหรับใชเปน

อุปกรณทดลองการทํางานอยางงาย 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -3- WWW.ETT.CO.TH 

 

  
 

 

 
 

รูปแสดง ลักษณะของบอรด ET-EASY168 STAMP  
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AVR Arduino Pin ET-EASY168 STAMP Pin Arduino AVR 
PD0 Digital-0 1 28 +5V(+Vin) +5V(+Vin) 

PD1 Digital-1 2 27 +VCC(+5V) +VCC(+5V) 

PD2 Digital-2 3 26 RESET# RESET(PC6) 

PD3 Digital-3 4 25 Analog-0 PC0/ADC0 

PD4 Digital-4 5 24 Analog-1 PC1/ADC1 

PD5 Digital-5 6 23 Analog-2 PC2/ADC2 

PD6 Digital-6 7 22 Analog-3 PC3/ADC3 

PD7 Digital-7 8 21 Analog-4 PC4/ADC4 

PB0 Digital-8 9 20 Analog-5 PC5/ADC5 

PB1 Digital-9 10 19 Analog-6 ADC6 

PB2 Digital-10 11 18 Analog-7 ADC7 

PB3 Digital-11 12 17 +VCC(+5V) +VCC(+5V) 

PB4 Digital-12 13 16 +AREF +AREF 

GND GND 14  15 Digital-13 PB5 
 

ตารางแสดง การจัดสรรขาสัญญาณของบอรด ET-EASY168 STAMP 
 

 
 

AVR Arduino Pin AVRISP Pin Arduino AVR 

PB3 Digital-11 MOSI +VCC +VCC +VCC 

- - NC GND GND GND 

RES# RES# RES# GND GND GND 

PB5 Digital-13 SCK GND GND GND 

PB4 Digital-12 MISO 
 

GND GND GND 

AVRISP 
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หนาที่ของขาสัญญาณในการใชงานแบบ “Arduino Project” 
• +5V(+Vin) เปนขาสําหรับใชเปนจุดรับแรงดันขนาด +5VDC จากภายนอกเพื่อใชเปนแหลงจาย

ไฟเล้ียงใหกับบอรด 

• +VCC(+5V) เปนขาแหลงจายไฟจุดเดียวกนักับที่ปอนใหกับ +VCC ของ MCU ซึ่งจุดนี้จะรับ

แรงดันมาจาก 2 แหลง ดวยกันคือ ขารับแรงดัน +5V(+Vin) จากขา 28 ของบอรด และ จากขา 

+VUSB(+5V) จากข้ัว USB ของบอรด โดยมี Diode ปองกันการยอนกลับของแรงดันไวแลว 

• +AREF เปนขาสําหรับรับสัญญาณแรงดันอางอิง (Analog Reference) ใหกับวงจร Analog Input 

ในกรณีตองการใชแรงดันอางอิงจากภายนอก 

• RESET# เปนขาสัญญาณ RESET ของ CPU ทํางานที ่Logic “0”  

• Digital[0..13] เปนขา I/O แบบ Digital สามารถใชงานเช่ือมตอกับสัญญาณ Logic TTL (5V) ตางๆ 

• Analog[0..7] เปนขา Input แบบ Analog สามารถรับ Input แบบ Analog 0..+5V 

 

หนาที่ของขาสัญญาณในการใชงานแบบ “AVR Micro Controller” 
• +5V(+Vin) เปนขาสําหรับใชเปนจุดรับแรงดันขนาด +5VDC จากภายนอกเพื่อใชเปนแหลงจาย

ไฟเล้ียงใหกับบอรด 

• +VCC(+5V) เปนขาแหลงจายไฟจุดเดียวกนักับที่ปอนใหกับ +VCC ของ MCU ซึ่งจุดนี้จะรับ

แรงดันมาจาก 2 แหลง ดวยกันคือ ขารับแรงดัน +5V(+Vin) จากขา 28 ของบอรด และ จากขา 

+VUSB(+5V) จากข้ัว USB ของบอรด โดยมี Diode ปองกันการยอนกลับของแรงดันไวแลว 

• +AREF เปนขาสําหรับรับสัญญาณแรงดันอางอิง (Analog Reference) ใหกับวงจร Analog Input 

ในกรณีตองการใชแรงดันอางอิงจากภายนอก 

• RESET# เปนขาสัญญาณ RESET ของ CPU ทํางานที ่Logic “0”  

• PB[0..5]  เปนขา I/O แบบ Digital สามารถใชงานเชื่อมตอกับสัญญาณ Logic TTL (5V) ตางๆ 

• PD[0..7]  เปนขา I/O แบบ Digital สามารถใชงานเชื่อมตอกับสัญญาณ Logic TTL (5V) ตางๆ 

• PC[0..5] เปนขา I/O ซึ่งสามารถกําหนดใหเปนไดทั้ง Digital และ Analog Input 

• ADC6,ADC7 เปนขา Input แบบ Analog สามารถรับ Input แบบ Analog 0..+5V 
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การพัฒนาโปรแกรมของบอรด ET-EASY168 STAMP 
 ในการพัฒนาโปรแกรมของบอรด ET-EASY168 STAMP นั้น ผูใชสามารถเลือกใชวิธีการพัฒนา

โปรแกรมได 2 รูปแบบดวยกัน คือ  

• AVR Micro Controller เปนการพัฒนาโปรแกรมตามรูปแบบของ AVR Micro Controller ปรกติ 

ซึ่งสามารถเลือกใชโปรแกรมภาษาใดๆก็ไดที่รองรับการใชงานรวมกับ AVR เบอร ATmega168 ซึ่ง

ผูใชสามารถเลือกใชโปรแกรมในการพัฒนาไดตามความถนัด เชน ภาษาเบสิก BASCOM-AVR 

หรือ ภาษาซี เชน Code Vision และ WinAVR เปนตน 

• Arduino Project เปนการพัฒนาโปรแกรมโดยใชโปรแกรมและชุดคําส่ังในการเขียนโปรแกรมดวย

ภาษาซี (C++) ของ “Arduino Project” ซึ่งเปนโครงการพัฒนาไมโครคอนโทรลเลอร AVR แบบ 

Open Source ซึ่งกําลังไดรับความนิยมอยางแพรหลาย เนื่องจากเปนโครงการที่เปดเผยทั้ง 

Source Code ในการพัฒนาใหทั้งหมดและยังมีตัวอยางโครงงานพรอมตัวอยางโปรแกรมการ

ทดลองตางๆแจกจายใหผูสนใจนํามาใชศึกษา เรียนรูและทดลอง ไดฟรี โดยไมเสียคาใชจายใดๆ

ผูสนใจสามารถเขาไปคนหารายละเอียดตางๆของ Arduino Project นี้ได http://www.arduino.cc/ 

 

******************************************************************************** 
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การติดต้ัง Driver ของ USB Bridge ของบอรด ET-EASY168 STAMP 
 บอรด ET-EASY168 STAMP จะใชชิพ USB Bridge ของ FTDI เปนตัวกลางในการเชื่อมตอกับ

คอมพิวเตอร PC โดย USB Bridge ของ FTDI จะทําหนาที่เปนตัวกลางในการเชื่อมตอและติดตอส่ือสาร

ระหวางเคร่ืองคอมพิวเตอร PC กับ MCU ATmega168 ของบอรด ET-EASY168 STAMP ในรูปแบบของ

พอรตอนุกรม (Visual Com Port) โดยโปรแกรม Application ตางๆที่ทํางานอยูบนคอมพิวเตอร PC รวมทั้ง

โปรแกรม Arduino จะมองเห็น พอรต USB ที่เช่ือมตอกับบอรด ET-EASY168 STAMP เปนพอรตส่ือสาร

อนุกรม (Com Port) ชองหนึ่งเทานั้น ซึ่งถาเคร่ืองคอมพิวเตอรของผูใชเคยทําการติดต้ัง Driver สําหรับ USB 

Bridge ของ FTDI ไวกอนแลว เมื่อทําการเช่ือมตอสาย USB ของบอรด ET-EASY168 STAMP เขากบั USB 

HUB ของเคร่ืองคอมพิวเตอร PC แลว Windows จะทําการติดต้ัง Driver ใหเองโดยอัตโนมัติ แตถาเคร่ือง

คอมพิวเตอร PC ยังไมเคยติดต้ัง Driver ของ FTDI ไวกอนก็จะตองทําการติดต้ัง Driver ใหกับบอรดให

เรียบรอยเสียกอนซึ่งมีลําดับข้ันตอนดังนี้ 

1. เตรียมแผน CD ROM ที่บรรจุ Driver ของ FTDI ไวใหพรอม หรือ ในกรณีที่ผูใชไดทําการติดต้ัง

โปรแกรมของ Arduino ไวเรียบรอยแลว ภายในโฟลเดอรของโปรแกรม Arduino ก็จะมี Driver ของ 

FTDI จัดเตรียมไวใหเรียบรอบแลว โดยจะอยูที่ “C:\arduino-0012\drivers\FTDI USB Drivers\”  

2. ทําการเสียบสาย USB ของบอรด ET-EASY168 STAMP เขากับพอรต USB HUB ของเคร่ือง

คอมพิวเตอร PC ซึ่ง Windows จะตรวจพบอุปกรณใหม โดยเปน “FT232R USB UART” และ 

แจงใหผูใชทําการติดต้ัง Driver ใหกับอุปกรณ ดังรูป 
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3. ใหเลือก Install from list or specific location(Advanced) แลวเลือก Next ซึ่ง Windows ก็จะแจง

ใหผูใชระบุตําแหนงโฟลเดอรที่บรรจุไฟล Driver ของ FTDI ไว ก็ใหเลือกที่ Browse และเลือกไปยัง 

Drive และ โฟลเดอรที่เก็บไฟล Driver ไว ซึ่งถาผูใชไดทําการติดต้ังโปรแกรมของ Arduino ไวแลว ก็

ใหเลือกไปที่ “C:\arduino-0012\drivers\FTDI USB Drivers” แลวเลือก Next ดังรูป  
 

 
 

↓ 
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4. ในข้ันตอนนี้โปรแกรม Windows จะทําการคนหาและติดต้ัง Driver ใหกับอุปกรณ ใหรอสักครูจน

การทํางานเสร็จเรียบรอย แลวเลือก Finish ดังรูป 
 

 
 

↓ 
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5. หลังจากทําการติดต้ัง Driver ของฮารดแวรเรียบรอยแลว Windows ก็จะตรวจพบวามีอุปกรณใหม

ถูกเช่ือมตออยู โดยเปนอุปกรณประเภท “USB Serial Port” และแจงใหผูใชทําการติดต้ัง Driver 

ใหกับอุปกรณใหมที่ระบุเปน “USB Serial Port” อีกคร้ังหนึ่ง ซึ่งก็ใหเลือกระบุตําแหนงโฟลเดอรที่

เก็บไฟล Driver ไว ซึ่งใหเลือกเหมือนข้ันตอนในหัวขอที่ 3 ดังรูป 
 

 
 

↓ 
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6. ในข้ันตอนนี้โปรแกรม Windows จะทําการคนหาและติดต้ัง Driver ใหกับอุปกรณ ใหรอสักครูจน

การทํางานเสร็จเรียบรอย แลวเลือก Finish ดังรูป 
 

 
 

↓ 
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7. หลังจากทําการติดต้ัง Driver เรียบรอยแลว ก็สามารถใชงานอุปกรณไดแลว แตเพื่อความถูกตองใน

คร้ังแรกนี้ควรตองเขาไปทําการตรวจสอบและปรับแตงคาใหกับอุปกรณกอน โดยในข้ันตอนนี้ใหไป

ที่ “My Computer → Control Panel → System → Hardware → Device Manager” แลว

ทําการตรวจสอบที่ Ports (COM&LPT) แลวดูที่ชื่อของ “USB Serial Port” ซึ่งใหผูใชจดจํา

หมายเลขของ Com Port ของอุปกรณดังกลาวไว เพื่อใชอางอิงถึงในการเรียกใชงาน ดังรูป 
 

 
 

8. ในข้ันตอนนี้ใหคลิกเมาสที่เคร่ืองหมาย (+) หนาหัวขอ Ports(COM&LPT) แลวมองหาอุปกรณที่ชื่อ 

“USB Serial Port” ตามที่เราไดทําการติดต้ัง Driver ไวเรียบรอยแลว หรือ ถาไมแนใจวาอุปกรณ

ดังกลาวใชอุปกรณที่เปนของบอรด “ET-EASY168 STAMP” หรือไม ใหทดสอบดวยการถอดสาย 

USB ออก รายช่ืออุปกรณดังกลาวจะตองหายไป แตเมื่อเสียบสาย USB กลับเขามาใหม รายช่ือ

ของอุปกรณดังกลาวก็จะตองปรากฏใหเห็นอีกคร้ัง ถาทุกอยางถูกตอง ก็ใหทําการคลิกเมาสที่ Tab 

รายช่ือของอุปกรณดังกลาว เมื่อปรากฏหนาตาง USB Serial Port  Properties ข้ึนมาแลวใหเลือก

ที่ Port Setting แลวเลือก Advance เพื่อเขาไปกําหนดคาใหกับอุปกรณใหเรียบรอย ดังนี้ 

a. USB Transfer Size →  Receive (Bytes) ใหกําหนดเปน 256 

b. USB Transfer Size → Transmit (Bytes) ใหกําหนดเปน 128 

c. BM Option → Latency Timer (mSec)  ใหกําหนดเปน 1 
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↓ 
 

 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -14- WWW.ETT.CO.TH 

 

การพัฒนาโปรแกรมของ ET-EASY168 STAMP แบบ Arduino Project 
 

 

 ตามปรกติแลวบอรด ET-EASY168 STAMP จะทําการ ติดต้ังโปรแกรม Bootloader ไวใหเรียบรอย

แลว โดยใช Bootloader ชื่อ “BOOT_EASY168_AUTO_16MHZ.HEX” ซึ่งเปน Bootloader ที่ทางทีมงาน 

อีทีที ไดนําตนฉบับจาก Arduino มาปรับปรุงเงื่อนไขการทํางานใหม เพื่อใหการทํางานสอดคลองกับระบบ

ฮารดแวรของบอรด ET-EASY168 STAMP ไดดียิ่งข้ึน โดยโปรแกรม Bootloader นี้จะใชสําหรับ

ติดตอส่ือสารเพื่อส่ัง Upload Code จากคอมพิวเตอร PC ใหกับ MCU ในบอรดทํางาน โดยไมตองใชเคร่ือง

โปรแกรมภายนอกใหยุงยาก ซึ่ง คุณสมบัติของ Bootloader ที่ทาง อีทีที ปรับปรุงเพิ่มเติมข้ึน มีคุณสมบัติ

การทํางานเปนดังนี้ 
 

- ส่ือสารกับโปรแกรมภายนอกดวย Protocol แบบ STK500 (STK500V1) 

- ใชความเร็ว Baudrate 19200 โดยใชความถี่ XTAL 16 MHz 

- โปรแกรม Bootloader มีขนาด 2KByte ทํางานที่ตําแหนง 0x3800-0x3FFF 

- ใช LED ที่ตอกับขา Digital-13(PB5) เปนตัวแสดงสถานะในขณะที่ Bootloader ทํางาน  

- โปรแกรมใน Bootloader จะทํางานโดยอัตโนมัติทุกคร้ังหลังการรีเซ็ต โดย MCU จะเร่ิมตนทํางาน

ใน Bootloader นี้กอนเสมอ ซึ่งถาไมมีการติดตอสื่อสารจากโปรแกรม Arduino ภายในเวลา

ประมาณ 3 วินาที MCU ก็จะออกจากการทํางานใน Bootloader เพื่อไปเร่ิมตนทํางานตามคําส่ังที่

เปนของผูใช โดยอัตโนมัติ โดยในขณะที่ Bootloader ทํางาน ตอนเร่ิมตนจะเห็น LED ที่ตอไวกับ

ขาสัญญาณ Digital-13(PB5) กระพริบ 3 คร้ัง แลวติดคาง เพื่อรอการติดตอส่ือสารจากโปรแกรม

สําหรับส่ังใหทําการ Upload Code ใหกับ MCU ซึ่งถาไมมีการติดตอส่ือสารจากโปรแกรมของ 

Arduino ภายในระยะเวลาประมาณ 3 วินาที โปรแกรมก็จะกระโดดไปทํางานในตําแหนงเร่ิมตนที่

เปนสวนของโปรแกรมที่ผูใชเขียนข้ึนทันที  
 

นอกจากนี้แลวผูใชยังสามารถเปลี่ยนไปใชโปรแกรม Bootloader รุนมาตรฐาน ตามแบบโปรแกรม ของ 

Arduino ไดอีกดวย โดยใชโปแกรม Bootloader ที่ชื่อ “ATmegaBOOT_168_diecimila.hex” โดยไฟล

ดังกลาวจะถูกบรรจุไวใน Drive และโฟลเดอรเดียวกันกับที่ผูใชไดทําการติดต้ังโปรแกรมของ Arduino ไว

แลวคือ “C:\arduino-0012\hardware\bootloaders\atmega168\ATmegaBOOT_168_diecimila.hex” 
 

 แตอยางไรก็ตามในการทีจ่ะสามารถทําการติดต้ังโปรแกรม Bootloader Code ใหกบั MCU ไดนั้น 

ผูใชจําเปนตองมีเคร่ืองมือสําหรับทําหนาที่ Program Code ใหกับ MCU อยูดวย โดยใชเคร่ืองโปรแกรมที่มี

ข้ัวตอตามมาตรฐานของ “AVRISP” ของ ATMEL แบบ IDE 10 PIN ไดทันที โดยวิธีการใหศึกษาเพิม่เติม

จากหัวขอ “การโปรแกรม Bootloader ใหกับบอรด ET-EASY168 STAMP” ในตอนทายของคูมือนี ้
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การติดต้ังโปรแกรม Arduino  
 หลังจากที่เราไดทําการติดต้ัง USB Driver ใหกับบอรดเปนที่เรียบรอยแลว ก็เปนอันเสร็จส้ินข้ันตอน

ของการเตรียมการแลว ลําดับข้ันตอนตอจากนี้เปนตนไป ก็เปนเร่ืองของการใชงาน การเขียนโปรแกรม และ

การศึกษาเรียนรูตางๆตามความตองการแลว แตกอนอ่ืนเราจะตองทําการติดต้ังโปรแกรมของ Arduino เพื่อ

ใชเปนโปรแกรมสําหรับศึกษาเรียนรู ซึ่งมีลําดับข้ันตอนดังตอไปนี้ 

1. ทําการ unzip ไฟลชื่อ “arduino-0012-win.zip” ไวในฮารดดิสก ซึ่งขอแนะนําใหทําการ unzip ไวที่ 

Root นอกสุดใน Drive C โดยหลังจากทําการ unzip เรียบรอยแลวจะไดโปรแกรมอยูที่ 

“c:\arduino-0012” 

2. ทําการส่ัง Run โปแกรม “arduino.exe” จะไดผลดังรูป 
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3. ในคร้ังแรกของการเรียกใชงานโปรแกรม ใหทําการกําหนดระบบฮารดแวรที่จะใชงานกับโปรแกรม

ของ Arduino ใหเรียบรอยเสียกอน เนื่องจากในปจจุบันนี้ มีการออกแบบวงจรและสรางฮารดแวร

บอรดแบบตางๆสําหรับนํามาใชงานรวมกับโปรแกรมพัฒนาของ Arduino ไวมากมายหลายรุน โดย

ในกรณีของบอรด ET-EASY168 STAMP ใหทําการเลือกกําหนดชื่อบอรดเปน “Diecimila” โดย

คลิกเมาสที่ “Tools → Board → Arduino Diecimila”  ดังรูป 
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4. เลือกกําหนดหมายเลขพอรต สําหรับติดตอส่ือสารกับบอรด ใหตรงกับหมายเลข Comport ที่ไดทํา

การติดต้ัง Driver ของ USB ไวในตอนแรก เชน ถาตอนติดต้ัง Driver ของ USB แลวไดหมายเลข 

Comport เปน COM5 ใหคลิกเมาสที่ Tools → Serial Port → COM5  ดังรูป 
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5. ทดสอบเขียนโปรแกรม โดยคลิกเมาสที่ File → New แลวพิมพโปรแกรมทดสอบ หรืออาจใชการ

ส่ังเปดไฟลตัวอยางที่สรางไวแลวข้ึนมาแทนก็ได โดยในที่นี้ขอแนะนําใหทดสอบดวยโปรแกรมไฟ

กระพริบ โดยใหเลือก “File → sketchbook → Examples → Digital → Blink” ซึ่งจะไดดังรูป 
 

 
 

 

int ledPin = 13;              
 

void setup()                
{ 
  pinMode(ledPin, OUTPUT);   
} 
 

void loop()                  
{ 
  digitalWrite(ledPin, HIGH);   
  delay(1000);                   
  digitalWrite(ledPin, LOW);   
  delay(1000);                   
} 
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6. ส่ังแปลโปรแกรมโดยคลิกเมาสที่  “Sketch →  Verify/Compile” ดังตัวอยาง 
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7. ส่ัง Download Code ใหกับบอรด โดยคลิกเมาสเลือกที่ “File → Upload to I/O Board” แลวรอ

สักครูจนโปรแกรมทํางานเสร็จ ซึ่งควรไดผลดังรูป 

 

 
 

8. หลังจากที่ทําการ Upload Code ใหกับบอรดเปนที่เรียบรอยแลว บอรดก็จะเร่ิมตนทํางานตาม

คําส่ังที่เขียนไวในโปรแกรมทันที โดยจะสังเกตเห็น LED กระพริบ ติด และ ดับ สลับกันไปมา ดวย

ความเร็วประมาณ 1 วินาที ตลอดเวลา 
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การโปรแกรม Bootloader ใหกับบอรด ET-EASY168 STAMP 
 ตามปรกติแลวบอรด ET-EASY168 STAMP ไดทําการโปรแกรม Bootloader ไวใหเปนที่เรียบรอย

แลว ผูใชสามารถใชงานไดทันที่ แตอยางไรก็ตามในกรณีที่ตองการเปล่ียนแปลง Bootloader หรือ เกิด

ความผิดพลาดในการใชงาน จนทําให Bootloader เสียหายไป ผูใชก็ยังสามารถทําการ โปรแกรม 

Bootloader ใหกับบอรดไดใหม โดยบอรด ET-EASY168 STAMP ไดออกแบบ ใหมีข้ัวตอ AVRISP สําหรับ

ใชเปนชองทางในการโปรแกรม Code ใหกับ MCU ไดโดยตรง ดวยเคร่ืองโปรแกรมทุกรุนที่มีข้ัวตอ ตรงตาม

มาตรฐาน AVRISP ของ ATMEL ไดทันที โดยในที่นี้จะขอแสดงตัวอยาง วิธีการ โปรแกรม Bootloader โดย

ใชเคร่ืองโปรแกรม ของ อีทีที รุน “ET-AVR ISP USB V1.0” โดยใชโปรแกรม “AVR Studio 4” ของ 

ATMEL เปนตัวจัดการ ซึ่งมีลําดับข้ันตอนดังตอไปนี้ 
 

1. ตอสาย USB ใหกับบอรด ET-EASY168 STAMP ในกรณีตองการใชไฟเล้ียงจากพอรต USB หรือ 

จายไฟเล้ียง +5V ใหกับบอรดที่ขา 28(+5V) 

2. ตอสาย USB ใหกับเคร่ืองโปรแกรม ET-AVR ISP USB V1 พรอมทั้งตอสายแพร 10 Pin ระหวาง

ข้ัวตอของ AVRISP ของทั้ง 2 บอรดเขาดวยกัน 

3. ส่ัง Run โปรแกรม AVR Studio 4 ดังรูป 
 

 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -22- WWW.ETT.CO.TH 

 

4. เลือกคลิกเมาสที่ Tools → Program AVR → Connect.. →  STK500 or AVRISP จากนั้นก็ให

เลือกหมายเลขของ Comport ที่เปนของเคร่ืองโปรแกรม ET-AVR ISP USB V1 ตามที่ลง Driver ไว

พรอมกับเลือก Connect (จากตัวอยางเปน Com9) ดังรูป 

 

 
 

↓ 
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5. หลังจากที่ทําการ Connect เรียบรอยแลวใหทดสอบการเช่ือมตอโดยเลือกที่ tab ของ Main พรอม

กับเลือกเบอรของ MCU เปน ATmega168 และเลือก Programming Mode and target Settings 

เปน ISP mode แลวทดสอบเลือก Read Signature ดู ซึ่งถาทุกอยางถูกตองควรไดผลดังรูป 

 

 
 

6. ใหเลือกไปที่ tab ของ Program พรอมทั้งเลือก ตัวเลือกตางๆดังนี้ 

• Device ใหเลือก Erase device before flash programming และ Verify device after 

programming 

• Flash ใหเลือก Input HEX File เปน BOOT_EASY168_AUTO_16MHZ.HEX จากนั้นให

เลือกที่ Program เพื่อส่ัง Program Bootloader ใหกับ MCU ซึ่งจะไดผลดังรูป 
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7. หลังจากที่ทําการโปรแกรม Code ใหกับ MCU เรียบรอยแลว ใหเลือกมาท่ี Tab ของ Fuses เพื่อทํา

การสั่งโปรแกรม Fuse Bit ใหกับ MCU โดยใหเลือกกําหนดคาตัวเลือกดังนี้ 

 

• BOOTSZ ใหเลือกเปน Boot Flash size = 1024 word start address = $1C00 

• BOOTRST ใหเลือก Enable 

• SPIEN ใหเลือก Enable 

• SUT_CKSEL ใหเลือกเปน Ext.Crystal Osc 8.0MHz;Start-up time PWRDN/RESET : 

16K CK/14 ซึ่งเปนตัวเลือกดานลางสุด  

 

เมื่อเลือกตัวเลือกตางๆครบแลวจึงส่ัง Program ซึ่งควรไดผลดังรูป 

 

 
 

8. หลังจากทําการส่ัง program  Fuse Bit เรียบรอยแลว ใหเลือก Tab มาที่ LockBits แลวเลือกการ

Protect เฉพาะ Bootloader โดยเลือก BLB1 เปน LPM and SPM prohibited in Boot Section 

แลวส่ัง program เปนอันเสร็จส้ินกระบวนการ Program Bootloader 
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การโปรแกรม USB Bridge ของ FTDI ใหพอรต USB จายกระแสได 500mA 
 ตามปรกติแลว USB Bridge ของ FTDI เบอร FT232R จะถูกกําหนด Configuration คาใหใช

แหลงจายจากพอรต USB โดยตามคามาตรฐานของ USB Driver ของ FTDI นั้นจะรองขอกระแสไฟ ไปยัง 

USB Host เพียงแค 90mA เทานั้น ซึ่งตามมาตรฐานแลวพอรต USB สามารถจายกระแสไฟใหกับอุปกรณที่

เชื่อมตอดวยสูงสุดที่ 500mA ซึ่งเพื่อความสะดวกในการทดลองตางๆ ดวยบอรด ET-EASY168 STAMP ใน

กรณีที่ยังไมไดเชื่อมตอกับอุปกรณภายนอกมากมายนัก(ใชกระแสไมเกิน 500mA) เราก็สามารถเขาไปส่ัง

แกไขเปล่ียนคา Configuration ของ USB HUB เพื่อใหจายกระแสออกมาใหครบ 500mA ไดดวย ซึ่งจะทํา

ใหเกิดความสะดวกและคลองตัวในการทดลองตางๆมากข้ึนดวย แตอยางไรก็ตามถาหากวาผูใช ทําการตอ

ทดลองกับ เคร่ืองคอมพิวเตอรแบบ Notebook ที่ใชกระแสไฟจาก Battery หรือมีการเช่ือมตอบอรดทดลอง

กับอุปกรณที่ใชกระแสไฟมากๆ ก็ควรจัดหาแหลงจายไฟภายนอกเพ่ือจายใหกับบอรดเองจะเหมาะสมกวา 

ขอแนะนํานี้เปนการแนะนําสําหรับผูที่ตองการทดสอบการทํางานหรือทดลองเขียนโปรแกรมกับบอรด แบบ

ที่ไมไดเนนการเช่ือมตอกับอุปกรณภายนอกมากมายนัก เชน ทดสอบไฟกระพริบ โดยใช LED เปนอุปกรณ

การทดลอง หรือ การรับสงขอมูลกับพอรตส่ือสารอนุกรม เปนตน  

 โดยการแกไขคา Configuration ของ USB Bridge ของ FTDI จะใชโปรแกรม “MProg.exe” เปน

ตัวจัดการโดยมีลําดับข้ันตอนดังตอไปนี้ 

1. ตอสาย USB ของบอรด ET-EASY168 STAMP เขากับพอรต USB แลวส่ัง Run Program MProg 

ซึ่งจะไดผลดังรูป 
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2. ส่ังโปรแกรม “mProg” คนหา  USB Bridge ที่ติดต้ังไวในเคร่ือง โดยเลือกที่เมนู  Device → Scan 

ซึ่งควรไดผลดังรูป 
 

 
   

3. ส่ังอานคา Configuration เดิมของ FTDI ออกมา โดยเลือกที่ Tools → Read and parse ซึ่งควร

ไดผลดังรูป 
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4. ใหทําการแกไขคา Configuration ในสวนของ USB Power Options ใหเลือกเปน Bus Powered 

และกําหนดคา Max Bus Power จากเดิมที่กําหนดไวที่ 90 milli Amps เปน 500 milli Amps สวน

คา Configuration อ่ืนๆไมตองเปลี่ยนแปลง จากนั้นใหทําการบันทึกคา Configuration ไวในเคร่ือง

กอนโดยใหเลือกที่ File → Save As.. ดังรูป 
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5. ส่ังโปรแกรมคา Configuration คืนใหกับ FTDI โดยใหเลือกที่ Device → Program แลวรอจน

โปรแกรมทํางานเสร็จ หลังจากนั้นให ถอดสาย USB ออกแลวเสียบกลับเขาไปใหม USB ก็จะ

ทํางานตามคา Configuration ใหมไดแลว 
 

 
↓ 
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การพัฒนาโปรแกรมของ ET-EASY168 STAMP แบบ AVR Microcontroller 
 

 ในกรณีที่ผูใชตองการที่จะพัฒนาโปรแกรมใหกับบอรด ET-EASY168 STAMP แบบปรกติ ใน

รูปแบบของไมโครคอนโทรลเลอร AVR ก็สามารถทําได โดยสามารถเลือกภาษาในการเขียนโปรแกรม ไดเอง 

ซึ่งในกรณีนี้ผูใชสามารถเลือกใชภาษาใดๆก็ไดที่รองรับการใชงานกับ MCU ตระกูล AVR เบอร 

ATmega168 โดย ผูใชงานสามารถบริหารจัดการระบบทรัพยากรตางๆที่อยูภายในตัว ATmega168 ไดเอง

ทั้งหมด โดยสามารถทําได 2 แนวทางคือ 

 

• การพัฒนาโปรแกรมโดยใชเครื่องโปรแกรมภายนอก ในกรณีนี้จะมีขอดีคือ ไมสูญเสีย

ทรัพยากรใดๆเลย ผูใชสามารถใชงานและกําหนดคุณสมบัติการทํางานของทรัพยากรตางๆที่มีอยู

ใน MCU ไดเอง ตามตองการ แตมีขอเสียคือ ตองมีเคร่ืองโปรแกรมภายนอก สําหรับทําหนาที่ 

โปรแกรม Code ใหกับ MCU โดยสามารถใชไดกับเครื่องโปรแกรมทุกรุนที่ รองรับการใชงานกับ 

MCU เบอร ATmega168 และมีข้ัวตอตามมาตรฐาน AVRISP ของ ATMEL 

 

• การพัฒนาโปรแกรมโดยใชงานรวมกับ Bootloader ในกรณีนี้จะมีขอดี คือ เมื่อทําการเขียน

โปรแกรมเสร็จแลวสามารถส่ัง Program Code ใหกับ MCU ผานทางโปรแกรม Bootloader ที่

ติดต้ังไวแลวไดทันที โดยไมตองใชเคร่ืองโปรแกรมภายนอก แตมีขอจํากัด คือ ตองเสียพื้นที่

หนวยความจํา Flash สําหรับเก็บ Code โปรแกรมไป 2KByte (0x3800 -0x3FFF) เพื่อใชติดต้ัง

โปรแกรม Bootloader ซึ่งตามปรกติแลวบอรด ET-EASY168 STAMP จะทําการ ติดต้ังโปรแกรม 

Bootloader ไปใหเรียบรอยแลว โดยในกรณีนี้ผูใชจะสามารถเขียนโปรแกรมใชงานไดทั้งหมด

จํานวน 14 Kbyte จากที่มีอยูทั้งหมด 16Kbyte โดยตองเขียนโปรแกรมใหมีตําแหนงการทาํงานของ 

Code อยูระหวางตําแหนงแอดเดรส 0x0000 ถึง 0x37FF (0x1C00 - 0x1FFF K Word) สวน 

SRAM,EEPROM และทรัพยากรอื่นๆที่มีอยูใน MCU ผูใชยังสามารถใชงานไดครบตามจํานวนที่มี

อยูในตัว MCU ทุกประการ 
 

 

 

 

 

 

 

 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-EASY168 STAMP 

ETT CO.,LTD -30- WWW.ETT.CO.TH 

 

ตัวอยางการพัฒนาโปรแกรมดวย WinAVR โดยใชงานรวมกับ Bootloader 
ตัวอยางที่จะแสดงตอไปนี้จะแสดงใหเห็นวิธีการพัฒนาโปรแกรมใหกับ ATmega168 ดวยภาษาซี 

โดยใชโปรแกรม AVR Studio4 ของ ATMEL รวมกับ Compiler ภาษาซีของ WinAVR 

1. ส่ัง Run Program AVR Studio4 
 

 
 

2. ส่ังสราง project ใหม โดยเลือกที่ project → New project จากนั้นเลือกกําหนดตัวเลือกตางๆ

ใหกับโปรแกรมดังนี้ 

• Project type เลือกกําหนดเปน AVR GCC 

• Location สําหรับบันทึก project ใหระบุตําแหนง Folder ที่ตองการใชบันทึกไฟล และ Code

ตางของ project ในตัวอยางกําหนดไวที่ “C:\test_easy168\” 

• Poject name ใหกําหนดช่ือ project ตามตองการในตัวอยางกําหนดเปน “led_blink” และให

เลือก Create initial file ไวดวย ซึ่งเมื่อเราทําการกําหนดช่ือ project name เสร็จแลว โปรแกรม

จะสรางไฟล ที่มีชื่อเดียวกันกับ project name ใหเองโดยอัตโนมัติ 
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3. เมื่อกําหนดคาตัวเลือกตางๆ ใหกับโปรแกรมเรียบรอยแลว ใหเลือกที่ Next แลวกําหนดคาใน 

Debug platform เปน AVR Simulator และเลือก Device เปน ATmega168 ดังรูป 

 

 
 

↓ 
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4. ใหพิมพคําส่ังของโปรแกรมสําหรับทดสอบการทํางาน ในหนาตาง Text Editor ของโปรแกรม โดย

ในที่นี้จะทดสอบดวย Codeโปรแกรม สําหรับทําหนาที่เปนไฟกระพริบที่ PB5 ซึ่งเปน LED ที่ติดต้ัง

ไวบนบอรด ET-EASY168 STAMP อยูแลว ดังตัวอยาง 

 
/******************************/ 
/* Program Test LED Blinking  */ 
/* Board : ET-EASY168 STAMP   */ 
/* MCU   : ATmega168          */ 
/* X-TAL : 16.00MHz           */ 
/******************************/ 
 
#include <avr/io.h> 
#define  F_CPU 16000000UL   // X-TAL = 16 MHz 
#include <util/delay.h> 
 
#define PORT_LED PORTB  // Port Drive LED = PB 
#define DIR_LED  DDRB  // Port Direction  
#define LED 5                  // Pin Drive LED = PB5 
 
/********************/ 
/* Delay 1..65535 mS */ 
/********************/ 
void delay_ms(unsigned int time) 
{ 
  while(time-->0) 
  { 
    _delay_ms(1.0); 
  } 
} 
 
 
int main (void) 
{ 
  DIR_LED  |= (1<<LED);  // Pin Drive LED = Out 
   
  while(1) 
  { 
    PORT_LED &= ~(1<<LED);  // Pin LED = 0 
 delay_ms(200); 
 
    PORT_LED |=  (1<<LED); // Pin LED = 1 
 delay_ms(200); 
  } 
} 
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5. หลังจากพิมพ Code โปรแกรมเสร็จแลวใหส่ังแปลโปรแกรม โดยเลือกที่ build →rebuild all ซึ่ง

ผลจากการแปลคําส่ังจะไดเปน HEX File ที่มีชื่อเดียวกันกับ project ที่สรางไว ดังรูป 
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การส่ังโปรแกรม Hex Code ใหกับบอรด ET-EASY168 STAMP ผาน Bootloader 
 

 ในการพัฒนาโปรแกรมของ บอรด ET-EASY168 STAMP ในรูปแบบของ AVR Microcontroller 

นั้น หลังจากที่ทําการเขียนโปรแกรม และส่ังแปลคําส่ังจนได HEX File เรียบรอยแลวในการส่ัง Program 

HEX Code ที่ไดจากการแปลคําส่ังของโปรแกรมนี้ ผานทางโปรแกรม Bootloader ของบอรดนั้น ขอแนะนํา

ใหใชโปรแกรม AVRDude โดยใชงานผาน AVRDudeGUI ซึ่งมีข้ันตอนดังนี้ 

1. ทําการสรางโฟลเดอรชื่อ AVRDUDE ไวใน Drive C (“C:\AVRDUDE\”) จากน้ันใหทําการ Copy 

โปรแกรมของ avrdude และ avrdudeGUI ไวใน “C:\AVRDUDE\” โดยจะมีทั้งหมด 3 ไฟลดวยกัน

คือ avrdude.exe, avrdude.conf และ avrdudegui.exe  

2. ส่ัง Run Program AVRDude.EXE แลวเลือกที่ Tab ของ Configuration ใหเลือกกําหนดคาตางๆ 

ดังตอไปนี้ 

 
 

หมายเหตุ ถาหมายเลข Comport  มากกวา com8 ใหพิมพหมายเลข Comport ลงไปในชองรับคา

ของ –P Port ไดเอง เชน com9 แตถาหมายเลข Comport มีคาเปน 2 หลักให เพิ่มเคร่ืองหมาย “\\.\” 

นําหนาช่ือหมายเลข Comport ลงไปดวย เชน ถาใชกับ Com13 ก็ใหกําหนดเปน  “\\.\com13” เปนตน 
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ใหทําการกําหนดคา Configuration ใหกับโปรแกรม AVRDudeGUI ดังนี้ 

• Location of avrdude ใหเลือกไปที่ชื่อและที่อยูของไฟล avrdude.exe ที่ไดติดต้ังไวตาม

ข้ันตอนที่ 1 ซึ่งก็คือ “C:\AVRDude\avrdude.exe” 

• -C Location of alternate configuration file ใหเลือกไปที่ชื่อและที่อยูของไฟล avrdude.conf 

ที่ไดติดต้ังไวตามข้ันตอนที่ 1 ซึ่งก็คือ “C:\AVRDude\avrdude.conf” 

• -p Device ใหเลือกเปน m168 

• -c Programmer ใหเลือกเปน stk500 

• -p Port ใหเลือกเปนหมายเลข Comport ตามที่ไดติดต้ัง Drive ของ USB(FTDI) ไว 

• -b Baudrate ใหเลือกกําหนดเปน 19200 

3. เปล่ียน Tab ไปที่ File แลวเลือกกําหนดสวนของ Flash โดยใหเลือก Write และ Verify พรอมทํา

กําหนดช่ือ HEX File ไฟล ที่ตองการจะโปรแกรม ซึ่งในที่นี้จะใช HEX File ที่ไดจากตัวอยางที่เขียน

ดวยภาษาซีของ WinAVR ซึ่งจะอยูใน “C:\test_easy\default\led_blink.hex” ดังรูป 
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4. เมื่อกําหนดคาตางๆใหกับโปรแกรมเรียบรอยแลว ใหเลือกที่ Execute ที่อยูใน Tab ของ Files  ซึ่ง

โปรแกรม avrdude จะเร่ิมตนทําการ โปรแกรม HEX File ใหกับบอรดทันที ใหรอจนเสร็จดังรูป 

 

 
 

5. หลังจากส่ังโปแกรมเสร็จใหรอสักครูประมาณ 3 วินาที บอรดจะเร่ิมตนทํางานทันที โดยจะเหน็ LED 

กระพริบ ติด และ ดับ สลับกันไปมาไมรูจบ ซึ่งถาตองการทดสอบการทํางานใหม ก็ใหลอง กด

สวิตช Reset ที่บอรด ซึ่งตอนเร่ิมตนจะเห็น LED กระพริบอยางเร็วจํานวน 3 คร้ังแลวติดคาง ซึ่ง

ชวงนี้เปนการทํางานของ MCU ตามโปรแกรมใน Bootloader ซึ่งเมื่อไมมีการติดตอส่ือสารเพื่อส่ัง

ใหโปรแกรมเขาทํางานในโหมด Program Code ของ Bootloader ภายในเวลา 3 วินาที MCU ก็จะ

จบการทํางานจากสวนของ Bootloader แลวกระโดดไปทํางานในสวนที่เปน Code ของผูใชเอง

ทันที ซึ่งหลังการรีเซ็ตทุกคร้ังจะเปนเชนนี้ไปตลอด โดยโปรแกรมที่เปนสวนของผูใชจะเร่ิมตนทาํงาน

หลังจากพนสภาวะรีเซ็ตไปแลวประมาณ 3 วินาที 

 



1
2

3
4

A B C D

4
3

2
1

DCBA
Title

N
um

ber
Revision

Size

A
4

D
ate:

10-N
ov-2008

Sheet    of 
File:

C:\ET-Easy168ST\ET-Easy168ST.D
db

D
raw

n By:

PB1(O
C1A

)
13

PB2(O
C1B/SS)

14

PB3(M
O

SI/O
C2A

)
15

PB4(M
ISO

)
16

PB5(SCK
)

17

PC0(A
D

C0)
23

PC1(A
D

C1)
24

PC2(A
D

C2)
25

PC3(A
D

C3)
26

PC4(A
D

C4/SD
A

)
27

PC5(A
D

C5/SCL)
28

PB0(ICP1)
12

PD
0(RX

D
)

30

PD
1(TX

D
)

31

PD
2(IN

T0)
32

PD
3(IN

T1/O
C2B)

1

PD
4(T0/X

CK
)

2

PD
5(T1/O

C0B)
9

PD
6(A

IN
0/O

C0A
)

10

PC6(RESET)
29

A
V

CC
18

A
REF

20

A
G

N
D

21

PB6(TO
SC1/X

TA
L1)

7

PB7(TO
SC2/X

TA
L2)

8

VCC 4GND3

PD
7(A

IN
1)

11

VCC 6GND5

A
D

C6
19

A
D

C7
22

U
2

A
TM

EG
A

168-TQ
FP32

D
CD

#
10

D
SR#

9

N
C

8

G
N

D
7

RI#
6

RX
D

5
V

CCIO
4

RTS#
3

D
TR#

2

TX
D

1

CTS#
11

CBU
S4

12
CBU

S2
13

CBU
S3

14

U
SBD

P
15

U
SBD

M
16

3V
3O

U
T

17

G
N

D
18

RESET#
19

V
CC

20

G
N

D
21

CBU
S1

22
CBU

S0
23

N
C

24

A
G

N
D

25
TEST

26

O
SC1

27

O
SC0

28

U
1

FT232R

Y
1

16M
H

z

C10

22pF

C11

22pF C9
100n

A
REF

R2
10k

S1
RESET

C3
100n

V
CC

C2

100n

C4

100n

V
CC

C8
100n

V
CC

C6

100n

C5100n V
CC

C1

100n

R41k
R51k

13579
10 8 6 4 2

CN
2

A
V

R ISP

V
CC

D
8

D
9

D
10

D
11

D
12

D
13

A
0

A
1

A
2

A
3

A
4

A
5

A
6

A
7

D
0/RX

D
1/TX

D
2

D
3

D
4

D
5

D
6

D
7

LED
1

PW
R

R1
4k7

V
CC

LED
2

D
13

R34k7

D
2

SM
-4004

V
CC

D
2

D
3

D
4

D
5

D
6

D
7

D
8

D
9

D
10

D
11

D
12

D
13

RESET
D

1/TX
D

0/RX

A
REF

A
0

A
1

A
2

A
3

A
4

A
5

A
6

V
CC

1234567891011121314

J1

1234567891011121314

J2

D
1

PM
EG

4005ET

V
CC

A
7

RESET
C7

10uF

V
BU

S
1

D
-

2

D
+

3

ID
4

G
N

D
5

SH
1

6

SH
2

7

SH
3

8

SH
4

9

CN
1

M
IN

I U
SB

V
CC

D
3

PMEG4005ET

V
CC


